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The members of the Pittsburgh chapter of the STC extend our deepest condolences to the victims and
families of the tragedy that occurred on September 11, and we stand behind America.

Online Help and Web Development
While not the only area of professional concentration, software documentation is a popular field for STC
members. Software documentation involves writing a variety of different types of documents, possibly for
different levels, in a variety of different media, depending on the users' needs. Online help and the web are
two delivery media that many technical writers use in the field of software documentation.

The October 2001 issue of Blue Pencil contains a number of articles focusing on these two areas. Topics
include how to decompile an online help system into its project files, a case story about converting
FrameMaker files to an HTML Help system, an article about the Philadelphia STC chapter's website
redesign, and much more. So read on if you are interested in online help and web development; even if you
don't do this type of writing in your work, you will still find some of the articles intriguing. I know I always
enjoy hearing about how others in the technical communication field do their work.

The STC Pittsburgh chapter would also like to welcome its new website coordinator, Joan Bondira.
Welcome, Joan, and thank you for volunteering your precious time!

Enjoy the October issue of Blue Pencil.

Thank you.

Christina Downs
Managing Editor, Blue Pencil
600 Latrobe-Derry Road
Apartment B
Loyalhanna, PA 15661
724-532-3669
Stcdowns@aol.com or Chrdowns@aol.com

Society for Technical Communication

Pittsburgh Chapter
P.O. Box 133
Pittsburgh, PA 15230
Contact: Mary Ecsedy
Phone: 412-422-0213
mary.ecsedy@verizon.net
www.stcpgh.org
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Blue Pencil is the official newsletter of the Society for Technical Communication (STC), Pittsburgh
chapter. It is published monthly from September through June by the Pittsburgh chapter to inform and
promote communication within the chapter and the Society.
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Blue Pencil invites writers to submit articles that they want to be considered for publication. Note: By
submitting an article, you implicitly grant a license to this newsletter to run the article and for other STC
publications to reprint it without permission. Copyright is held by the writer. Please let the editor know if
this article has run elsewhere and if it has been submitted for consideration to other publications.

Material contained in this publication may be reprinted by other STC chapters, provided credit is given.
Please send a copy of the reprint to the editor.

Readers are invited to submit ads, short articles, news, reviews, and other material of interest to technical
communicators by the 10th of the month prior to publication to:

Christina Downs
Blue Pencil Managing Editor
600 Latrobe-Derry Road, Apt. B
Loyalhanna, PA 15661
stcdowns@aol.com
724-532-3669

President's Column
By Heather Lum and Mary Ecsedy

Heather Lum's Message
Increasing family demands have had me thinking about stepping down early from the chapter presidency
for a while. Thanks to a perceptive and gracious offer to take over from Veep Mary Ecsedy, I decided to
end my term on September 30.

Mary recruited former Independent and Consultant SIG leader Alan Houser as her vice president, and I
thank both of these innovative, dedicated people for stepping in so readily. Thanks, too, to the enthusiastic
people who have served as officers and board members under my watch.

I want to give special thanks to the long-time board members and volunteers who keep our chapter running
smoothly from one year to the next. Now that I've seen things from the inside, their commitment to and
perpetual willingness to give up time for the STC is awesome to me.

Thanks for the opportunity to serve you,
Heather Lum

Mary Ecsedy's Message
This is a relatively small change amid the big ones in our lives right now, but we know it matters to our
members and, therefore, we are trying to make it a seamless one.

Heather and I began discussing the possibility of her stepping down as President sometime this past
summer, in order to allow her to focus on her own little user group for the time being. The world presents a
very complex interface to babies that needs lots of explaining, and they need her more right now than the
STC does. However, we still needed to find a good volunteer on relatively short notice to take my place as
Veep before Heather could step down. We were very fortunate that Alan Houser agreed to take on this
additional responsibility, and I want to thank him for graciously volunteering his time and energy to
oversee our meeting plans.

It has been an honor to serve as the Pittsburgh chapter Vice President, and I will try to live up to the high
bar set by my predecessors as President. I can't do it alone, however; and I want to thank the board
members and volunteers for all their hard work and their support. Heather is right: it has been inspiring to
see how dedicated these people are to their friends and colleagues. I want to especially thank Darlene
Mullenix and Marlene Miller, who have helped me so much. Finally, thanks to Heather for all of her
encouragement.
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Thank you all once again.

Regards,

Mary Ecsedy

P.S. It's pronounced "etch-a-dee", like etch-a-sketch.

Tools and Tips Column
An Introduction to RoboHELP Office
By Bob Mohr
If you are in the market for a help authoring tool (a.k.a. HAT), you may find just what you need in a
product called RoboHELP, which is produced by eHelp Corp. RoboHELP Office is actually a suite of
products that enable you create an assortment of help systems:

•  JavaHelp
•  WebHelp
•  HTMLHelp
•  OracleHelp
•  RTF-based help (.hlp files)

Of these, I am most familiar with HTMLHelp and WebHelp. HTMLHelp is the heir apparent to the
venerable RTF-based help applications that have been around since the early days of Windows. To view a
sample of an HTMLHelp application, click Start > Help in Windows 9x. Here, a .CHM file is launched
instead of an .HLP file. HTMLHelp is the solution for Windows apps; web apps are a little different.

That's where WebHelp comes in. Rather than a single file, the WebHelp side is a collection of files; the
number varies with the number of topics, graphics, and other components in your help application. One file
is designated as the launch point to display the help. WebHelp is touted as the way to provide help for
applications independent of platforms and browsers.

RoboHELP's authoring environment is simple to use and brimming with iconized functionality. The same
environment is used to generate HTMLHelp and WebHelp. As the following graphic shows, the basic
layout has project-level operations on the left and topics on the right.
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To create a new help application, you start by creating a new project. This is where your source files are
collected. You develop each topic file as its own (HTML) file. With RoboHELP's near WYSIWYG editor,
you can develop your topics, with prose, tables, and graphics, as easily as you would in Word. No worry
about HTML tags here. RoboHELP handles them behind the scenes for you.

If you're the type that likes to tinker with the tags, you can click the TrueCode tab to see the HTML view of
your topics. RoboHELP color-codes the tags to enhance readability. Click the WYSIWYG tab and you're
back to the other view.

Style sheets make it easy to control the appearance of your topics. RoboHELP employs the use of styles for
text and tables the same way Word does. Even the dialog boxes used to change the styles are similar to
Word's.

RoboHELP gives you easy and flexible control over pop-up windows, links, and frames through wizards
and dialog boxes. Over 70 dynamic HTML effects, like mouse-overs and drop-down/expanding text (both
horizontally and vertically) are available. Add an effect; then click a viewer icon to see how the topic will
look when viewed with a browser.

Adding index entries to your help system is easy. Highlight a word in your topic, then right-click and select
Add Index Entry. Or you can run the index wizard and let RoboHELP take its best shot at finding index
entries for you. Of course you can alter the index once created. I have found the index wizard to do a very
good job, and it is a big time saver.

A glossary can also be added to your HTMLHelp application. However, when your help file is installed on
a user's machine, you'll need to include a couple of DLL files to support the ActiveX components used.
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Complete instructions for doing this are included in RoboHELP's documentation. WebHelp does not
support the glossary function, but it does support the index function.

The larger your help applications become, the harder it is stay on top of what's done and what isn't.
RoboHELP has several built-in reports that show you where you are in the help's development.
Several utilities complement the authoring tools:

•  Multi-file Search and Replace
•  Graphic Resizer
•  Software Video Camera

The Multi-file Search and Replace utility not only works on the text in all topic files in the project; it also
works on the actual HTML tags. This is a great feature. Recently, I converted hundreds of Cold Fusion files
to HTML files. Many of the files contained links to files with .CFM extensions. Using the multi-file search
and replace utility, I was able to change the .CFM text to .HTM text in dozens of the links in a couple of
minutes.

As the name implies, the Graphic Resizer lets you resize images such as screen shots. It does a fair job.
(The graphic accompanying this article is a resized capture of a full-screen.) You can alter the color depth
between 16-bit, 24-bit, and 256 colors. You can also convert images to/from several file formats: JPG,
SHG, BMP, and GIF.

Ever wish you could show your readers how to do something rather than tell how to do it?  The Software
Video Camera lets you do just that. This little utility records every screen change and mouse click you
make and turns them into an AVI file. You can even include a voice-over with your AVI. Unfortunately,
AVI files can be quite large, and I wouldn't recommend adding very many to a help application; however,
there may be times when you want to show how a list of options changes according to another option
selected. Narration adds another dimension.  (BTW, using a free utility called Real Producer, you can
convert the AVI file into a streaming video file.)

Of course, RoboHELP's primary use is to develop online help applications. However, it can also be used to
develop other applications. RoboHELP comes with a variety of templates for several styles of online
documentation, including help applications, online books, slide shows, even corporate intranets. I have
used it to create knowledge bases and style guides.

And finally, RoboHELP's user manual is good, but I've found its own online help to be even better. It's
searchable, and employs all of the program's features. In addition, e-Help offers an online community
where help authors and RoboHELP experts share their knowledge. The cost of RoboHELP Office is about
on par with FrameMaker, and different levels of customer support are available.

If you are in the market for a help authoring tool, I recommend that you visit www.ehelp.com and
download the trial version of RoboHTML. I've found it to be a powerful, easy to use tool, and I'm sure you
will too.

Bob Mohr is a senior member of STC and a technical writer at BillingZone,LLC. He can be reached via e-
mail at bob.mohr@billingzone.com.

Employment Issues Column
What Skills are Clients Looking For?
By Pam Schmidbauer
Aquent-Associate Area Manager

Many people ask the agents in our office, "Just what are clients looking for in writers?" "What background
are they looking for?" "What skills are they most interested in?"
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It all seems to depend on the situations that clients find themselves facing.

Keep in mind that all client companies don't come from the same mold. Clients tend to look for
experienced writers with a track record in their area of focus. For instance, we had a client who would only
look at writers with telecommunications experience. This client was looking for someone who was industry
focused. Another client asked for someone who had years of experience in franchise writing.

Most of the positions Aquent fills on both a temporary and permanent basis require at least 2 years of
experience, regardless of industry or specific writing request.

Finding a niche and sticking with it can be very profitable as long as that industry stays healthy financially.
You can generally ask for more money from clients who are looking for a specific talent such as the
telecommunications example I gave.

I personally think that being multi-dimensional when updating your skills is helpful. That way if one
industry takes a dive, then you have something else to fall back on.

Something that is very important to all writers is to be detail-oriented. That is usually the number one
phrase a client uses after they tell us what skills they are looking for the writer to possess.

I would like to share with you a few of the skills that our clients typically ask for when requesting
proofreaders, copywriters, and technical writers.

Proofreading requires intense, focused concentration. Proofreading also requires extreme attention to detail
and sometimes persistence to keep focused on information that may not be the most interesting or
entertaining. Proofreading requires that the writer know and use the basic tenets of the English language
with confidence.

Clients usually ask for copywriters who can write marketing copy for brochures, catalogs, and content for
the web. Many times, clients want to see writing samples before they even interview someone. Through the
samples, they are looking for the experience it will take to solve their writing problem.

Technical writers in the computer industry produce copy for a wide variety of technical publications.
Clients usually ask for people who can write white papers, instructional manuals, product documentation
and online help. Clients usually request someone who has the ability to write consistent and clear
documentation, a talent who has the ability to interview technical staff about a product and translate that
information into language that non-specialists can understand. A technical writer must be able to test
documentation against the product, have the ability to edit and revise writing, and a curiosity about and
interest in technology.

Pam Schmidbauer is Associate Area Manager of Aquent's Pittsburgh office and can be reached at
pams@aquent.com or 412-322-4940. Aquent is the world's largest talent agency for creative professionals.
Headquartered in Boston, Aquent leverages both the Internet and a network of 55 offices in 12 countries to
provide independent professionals access to work, training, and the same insurance, retirement, and cash-
flow management benefits enjoyed by traditional W-2 workers. http://www.aquent.com.

Converting From FrameMaker to HTML Help
By Elizabeth Barrow

In the past year, our company has been developing a new user interface, which would have a basic
Windows look and feel. To be consistent  with  this interface, we decided to upgrade the help system we
were using.

Deciding on an Application
The first thing we needed to do was decide what software we would use to produce the documentation, and
also what form the end product would have. We had the following criteria:
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•  Since the software would be available for both Windows and UNIX (HP and Solaris) platforms, the
documentation had to be displayed on the same platforms.

•  If possible, we wanted to single-source: to produce the online documentation and the hardcopy
documentation using the same files.

•  Most of our current documentation was in FrameMaker, although a large amount was also in Microsoft
Word.

•  Cost was an issue, although that would depend on the decisions we would make using the other
constraints.

Because we used FrameMaker for so much of the previous online and hardcopy documentation, and
because the Word documents could be easily read into FrameMaker 6.0, we decided to use FrameMaker as
our production software. However, because we could only display FrameMaker files in a paged format, and
would like to offer our online documentation as smaller, variable-sized chunks, we decided that
FrameMaker was probably not the display format we wanted to use. In addition, Adobe was charging us
per-copy for shipping FrameViewer with our software.

We wanted to provide documentation that was easily printed, and that included page numbers for the
contents and index. Because so many of the application engineers liked using PDF, because the Acrobat
Reader could be distributed free, and because FrameMaker could produce PDF very easily, we decided to
use that form for documents such as reference and getting started guides.

Next, we had to address the online help system — documentation that was there for the immediate help of
the user, with links to more technical detail if needed. Although we could save FrameMaker files as
HTML, the files that provide the HTML Help look (the contents – HHC file, and the index – HHK file)
would have to be created by the writers. We investigated two conversion products, Webworks Publisher
and Mif2Go. Because Mif2Go could create an entire HTML Help project from a FrameMaker file or book,
and because it cost much less than Webworks Publisher, we decided to use Mif2Go.

We were concerned that compiled HTML Help, because it used components of Microsoft’s Internet
Explorer, would not work properly on UNIX systems. However, we tested it using the same software used
to develop our software on both types of platforms, and it seemed to have no problems.
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Creating Printable Documents
To create PDF using FrameMaker 6.0, you merely have to choose File>Save As and select PDF.  The
software allows you to select the paragraph styles that will create bookmarks, which will be listed to the
side of the document display. I created paragraph styles for the Contents and Index headings and included
them in the bookmarks, so that there would be an entry to get to those in the side panel. These headings
could be ignored when I was creating the table of contents for the FrameMaker document.

Once we selected the headings we wanted to include (generally a form of Heading or Subheading
paragraph format), we could simply choose Set, and the PDF file was created. This could be done with an
entire book as well as a single file.

Creating Online Help
Using Mif2Go was somewhat more complicated.  Setting it up requires copying DLL and EXE files to the
system folder and copying a DLL file to the FrameMaker plugins folder. Now, when we started
FrameMaker, there were two new menu items: File>Save Using mif2go and File>Set Up mif2go Export.
In addition, we needed to install the latest version of Microsoft’s HTML Help Workshop, to create
compiled HTML help (CHM) files. CHM files include the information for the graphics, contents, and index
in one file.
Setting Up Export

Before we saved a file (or a book) using mif2go, we had to set up the export options. A file called
mif2htm.ini is created in the destination directory that will contain the HTML and graphics files when
you choose File>Set Up mif2go Export. This mif2htm.ini file contains such information as the help
project (HHP) file name, the location of various files, and what the graphics file formats would be.
Most important, it maps the paragraph styles to HTML styles, which can in turn be defined in a
cascading style sheet. In this way, we were able to use sans-serif character formats for online help,
while using serif formats for hardcopy, using the same FrameMaker files and the same paragraph
styles. We did not use the FrameMaker contents (TOC) or index (IX) files for producing the HTML
Help, since the compiled HTML files would contain the needed information.

An additional initialization file, mif2go.ini, is placed in the source directory that contains the Frame
files. This mif2go.ini file determines the names of the HTML and graphics files created by mif2go. It
turned out that adjusting this file before saving using mif2go made work much easier. We changed the
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first entry in the [FILEIDs] section to have a descriptive name. In our case, this would mean changing
the entry
1welcome=aa to 1welcome=1welcome and 2starting=ab to 2starting=2starting.

Creating the HTML Help Project
Once we figured out what types of initial settings were needed, it was a simple matter to use the
File>Save Using mif2go command to save the HTML and graphics files. Mif2go also creates index,
contents, and project (HHP) files, which you can compile using Microsoft HTML Help Workshop.

Elizabeth Barrow has been a technical writer for over 10 years, with an emphasis on software and
online documentation. She also assists Shadyside Presbyterian Church with their web page
maintenance.

Practical Magic: Decompiling Help
By Neil Perlin, Boston Chapter

Editor's Note: This article originally published in Hyperviews:Online
(http://www.stcsig.org/oi/hyperviews/), the Web newsletter of the Society for Technical Communication
(STC) International Online Information Special Interest Group.

At some point in your online help development career, you may get a client who needs to update a help
system but has lost or deleted the component (“source”) files and only has the final HLP/CNT (WinHelp)
or CHM (HTML Help). Or you may see an unusual feature in a help system and want to know how the
developer created it. In each case, the answer is "decompilation."

Decompilation is the process of breaking down WinHelp’s HLP/CNT or HTML Help’s CHM into its
source files. Once you’ve decompiled a help system, you can:

•  Access its source files in a help authoring tool like RoboHelp or ForeHelp; modify the files –
adding or deleting topics, links, index entries, etc.; and recompile the files back into the finished
HLP/CNT or CHM for distribution. (When discussing help authoring tools, I focus on the two
most widely used – RoboHelp and ForeHelp. Others, like Doc-To-Help and HDK, also support
decompilation but are less well-known.)

•  View the codes in the source files to see how the original developer created the feature that
interests you.

In the early help development days, decompilation could be a difficult task, but current tools make it almost
effortless. Because it’s so easy, this column explains how to decompile using RoboHelp and ForeHelp
before moving to two larger issues – your reason for decompiling and how to interpret the results.

How To Decompile
WinHelp
Using:

•  RoboHelp Classic 9.X: Select RoboHelp Explorer’s Tools tab; run Help-To-Source; fill out the
entries on the two dialog boxes; and you’re done.
This process extracts the topic files, graphics files, and various control files. Clicking the Run
RoboHelp option on the Help-to-Source Wizard Results Summary dialog box then opens the
decompiled project in a new instance of RoboHelp where you can modify and recompile it.

•  ForeHelp: ForeHelp doesn’t come with a WinHelp decompiler, but you can get it by either
contacting ForeHelp technical support or searching for it on the Microsoft site. (ForeFront uses
Microsoft’s own decompiler.)
Once you download the decompiler, install it in the folder that contains the HLP/CNT to be
decompiled, and run it to extract the project file and topic file(s). You can then open the project
file in ForeHelp or start a new WinHelp project in ForeHelp and import the topic files.
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HTML Help
Using:

•  RoboHelp HTML 9.X: Select the Tools tab on the RoboHelp Explorer, and run the HTML Help
Studio utility.
This process lists the topic files, graphics files, style sheets, index, table of contents, browse
sequences, and glossaries. You can then select which ones to extract for use in another HTML
Help project.

•  ForeHelp HTML: Select Project/Decompile CHM File. Select the CHM file to decompile; select
the individual files and items to extract; and select the folder in which to place the files. You can
then use these files in another HTML Help project.

•  HTML Help Workshop: Select File/Decompile; specify the CHM file to decompile; and specify
the target folder in which to place the files. You can then use these files in another HTML Help
project.

Now What?
The next step depends on why you wanted to decompile the help system.

•  If you just want to modify the source files in a help authoring tool and recompile, it should be
simple. If you’re working on a WinHelp project, and the original developer followed at least
minimally good coding practice, you should be able to open the project in your help authoring tool
and go to work. If you’re working on an HTML Help project, with the same qualifications about
the original developer, you should be able to import the extracted files into a new project and go to
work.

•  If you want to view the codes to see how the original developer created some feature, this gets
more complex because you’ll need to understand the codes. The last part of this article presents a
quick review of the codes in WinHelp and HTML Help projects.

It’s getting hard to find detailed information about either format. There’s little available on WinHelp since
most of the books are long out of print. HTML Help is more recent, but few code-level books ever
appeared because most developers were moving to help authoring tools in place of hand coding, so there
was little demand for code-level information.

For WinHelp, you can get an overview of the codes from a 1999 presentation that I gave at Help University
at http://www.hyperword.com/resources.htm#under. You can also look for two books – Designing
Windows 95 Help by Deaton and Zubak and Developing Online Help for Windows 95 by Boggan, Farkas,
and Welinske. Both are out of print, although the latter was re-released and was available at
http://www.solutionsevents.com/ as of late June, 2001.

For HTML Help, there’s one book that’s long outdated but still a good underlying source - Official
Microsoft HTML Help Authoring Kit by Steve Wexler, which is available at http://www.amazon.com/. You
can also try help-related bulletin boards like groups.yahoo.com/group/HATT.

If you decompile a help file to see the code that’s running a feature, it’s easy to copy that code and use it in
your own help system. Mechanically, nothing is stopping you, but if a decompiled help system is
copyrighted, reusing code may violate the owner’s copyright. It’s also wrong on general principle. If you
see a feature that you want to reuse, better to contact the copyright holder and try to get permission. It’s
very likely that no one at the company will have the slightest idea what you’re talking about and their legal
department may say no on general principle, but it’s still the right (and safe) thing to do. If you’re unsure,
there are two things to do.

•  Contact your company’s legal department for guidance.
•  Check a WinHelp coding reference book to see whether the code you’re looking at really is

proprietary or just a neat implementation of standard codes, in which case there’s probably
nothing to worry about.
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Interpreting the Results – A Quick Code Overview
WinHelp
You’ll find some or all of the following file types in a WinHelp project:

Extension Contains WinHelp Version Required/
Optional

DOC Contents plus control and format codes. 3.1, 4 Optional
RTF Compilable form of DOC file. 3.1, 4 Required
HPJ Compilation control and, optionally, the

context-sensitivity control codes.
3.1, 4 Required

H, HH, HM The file(s) that typically contain the context-
sensitivity control codes.

3.1, 4 Optional

HLP Compiled help file. 3.1, 4 N/A
CNT The codes that create the Contents tab 4 Optional
BMP, DIB, SHG,
WMF

Graphic file formats. 3.1, 4 Optional

If you use RoboHelp Classic or any other authoring tool that run on top of Word, you’ll see some or all of
the following codes at the top of each topic:

Code Specifies
# The topic ID. The only required code.
$ The topic title specified using a code in order to display on the Index and Find tabs.
K The keywords that form the Index tab and that are used by the Klink macro.
A The keywords used by the Alink macro to create Related Topics lists.
+ The browse sequence code.
! The topic entry macro(s).
* The build tag for conditional builds at the topic level.
> The default window type in which to display a topic when it’s opened from the Index or Find tab

or via a KLink or ALink macro.
To view or edit these codes, called footnote codes, place the pointer in the topic whose codes you want to
edit. Then, in Word either:

•  Select View/Footnotes to view all the footnote codes in this file in the Footnote pane.
•  Select View/Page Layout, and scroll to the bottom of the page to view the current topic’s codes.

To insert new footnote codes manually, use Word's custom footnote feature:
1. Place the pointer at the code insertion point.
2. Select Insert/Footnote.
3. Select Custom Mark and type the code symbol.
4. Click OK to insert the code.
5. Type the code value in the footnote area.
To move or delete a footnote code, select the code character on the topic title line and not in the footnote
region.
HTML Help
You’ll find some or all of the following file types in an HTML Help project:

Code Specifies
HTM Topic files containing the contents, graphics, and formatting codes.
HHP The compilation control file, or "project file."
HHC The codes and entries for the Contents tab.
HHK The codes and entries for the Index tab.
CSS A cascading style sheet file that controls the appearance of the HTM files.
GIF, JPG, PNG Graphic file formats.
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CHM The compiled, distributable file.

Neil Perlin has 22 years experience in technical writing, with 16 in development, consulting, and training
for various types of online documentation and tools including WinHelp, HTML Help, CE Help, RoboHelp,
and some now known only in legend. Neil writes about online documentation, speaks to computer societies,
the STC, and other groups, and is a senior member of the Boston chapter of the STC. He offers training,
consulting, and development for various types of online documentation, XML, and the mobile wireless web
through Hyper/Word Services of Tewksbury, MA. He can be reached at nperlin@concentric.net,
http://www.hyperword.com/.

Effective Hyperlinks: What We Can Learn from Books
By Jean-Luc Doumont, Belgian Chapter

Editor's Note: This article originally published in Hyperviews:Online
(http://www.stcsig.org/oi/hyperviews/), the Web newsletter of the Society for Technical Communication
(STC) International Online Information Special Interest Group.

Web hype has misled many into thinking that hypertext is an Internet invention. Regardless of when the
term was coined, the idea of linking one piece of writing to another is no recent one. While new media may
open up new possibilities, traditional paper documents still offer a robust model of hyperlinks. This article
first provides a rationale for navigation, then offers guidelines for effective Web navigation, and finally
organizes hyperlinks in three main types, much inspired by books.

A Rationale for Navigation
Communication, like most aspects of our lives, is a time-mediated process. Instances of communication,
therefore, are sequences of some kind, even if individual events in these sequences, such as a photograph or
even a voice quality, may seem largely nonsequential. The sequence may or may not be imposed on the
receiving party: it is strongly imposed by a video segment, less so by a well-structured text, and even less
by a graphical representation.

Humans describing a trajectory, whether it be a physical journey or a communication sequence, want
answers to questions. They want to know where they are. They want to know where they are going to.
Possibly, they want to be reminded of where they came from. Effective communication, no matter its
nature or its medium, provides answers.

Humans, embarking upon trajectories for a given purpose, usually look for ways to control their trajectory
so as to reach their purpose, or reach it faster. To make decisions, they need to know what the options are
and what consequences choosing a given option bears. Effective communication, no matter its nature or its
medium, allows informed decisions.

Traditional paper documents, especially the longer and maybe more structured ones such as books, carry a
surprising amount of navigational information, both by nature and by contents. As physical embodiments
of the communication sequence, they provide numerous clues as to where readers are (for example, near
the beginning or somewhere in the middle). Numbered headings and, especially, running headlines or
footlines further help readers locate their current position in a structure often rendered explicit by a table of
contents. This table of contents, possibly together with a document overview at the end of the introduction,
allows readers to make choices about where to go. So does an index, along different logics. Finally, the
references to tables and figures, to bibliographical entries, and to other parts of the document are as many
“hyperlinks”.
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Document navigation, in other words, is by no means an Internet invention. For centuries, carefully
designed paper documents have provided both motivation and means for readers to jump to other parts of
the page, to other pages of the document, or to other documents altogether. By allowing such a jump at a
click of the mouse, computers simply make navigation faster and easier, yet at the risk of disorienting the
visitors.

To allow informed decisions, Web pages must tell visitors what they can expect to find by following links.
Traditional paper documents, being limited to explicit and largely conventional links, often offer reasonable
clues for informed decisions, a noteworthy exception being the footnote. By contrast, computer documents,
which can make a hyperlink of any word or graphical element on the page, can render hyperlinks cryptic.

Guidelines for Web Navigation
Traditional paper documents provide an excellent reference model for designing the navigation of a Web
site and thus helping visitors know where they are and decide where to go.

Helping visitors know where they are supposes a reference structure. Though virtual documents could
easily assume any conceptual structure, a hierarchical or tree-like structure is probably the easiest one for
visitors to perceive and memorize and for Web authors to signpost, usually in two ways:

•  A table of contents, usually called a site map for Web documents, provides visitors with a global
view of the Web site's structure.

•  A hierarchical path on each page, the equivalent of a running headline or footline, indicates to
visitors where the page fits in the site's hierarchical structure.

Because visitors lack the clues readers may gain from the physical nature of a paper document, situating a
page explicitly in the site's structure is all the more important. In contrast to running headlines or footlines,
which typically situate the page within one or maximum two levels, Web pages best display a full
hierarchical path, possibly reflected in the page's URL. Similarly, they usefully remind visitors of what site
they are visiting, for example by all pages displaying the sponsor's logo. (This logo could, for example, be a
hyperlink to the home page—an emerging convention adopted by more and more Web sites.)

Helping visitors decide where to go supposes to let them know both what links are available to them and
what they will find (or, better, what they will gain) by following a link.
Effective links are highly visible and identifiable as links, without drawing undue attention onto
themselves. On scrollable pages, main links appear near the top of the page and may be repeated at the
bottom. Verbal links differentiate themselves from other words by their appearance or their position on the
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page (or both). Graphical links are identified as links by their appearance (suggesting a button) or by
accompanying text.

Effective links clearly indicate their destination on their own. They require little surrounding text, if any,
and no mouse-over pop-up explanation, even if they can benefit from such explanations as a form of
effective redundancy (graphical links, for example, benefit from text alternatives). Three examples of
ineffective hyperlinks are (1) the “click here” syndrome, conveying no information in the link itself (the
explanation is in the surrounding text), (2) hyperlinked words as part of a sentence, providing no clue as to
the destination (unless a clear code has been established), and (3) mystery boxes, revealing their destination
only when the mouse passes over them (see my article in IEEE Prof. Commun. Soc. Newsletter 44:2 of
March/April 2000).

Three Types of Hyperlinks
Possible destinations for navigational links may be organized in three types, found in paper documents:
start there, continue there, and go there and back.

Start there links help visitors locate from the onset the information they seek. They can reflect the site's
structure and thus form a partial or full table of contents, possibly repeated on every page or as one of the
panels in multi-panel frames. They can also allow random access to pages, regardless of the site's structure,
and thus form an index, either limited to keywords (like the index of paper documents) or allowing simple
or complex searches on any word or combination of words.

Well-phrased items in a table of contents go a long way towards helping visitors decide where to start. As
in paper documents, however, they may not suffice to allow informed decisions. A site map may therefore
usefully be complemented by some text orienting visitors on the basis of their purpose (possibly as
explicitly as with if you…, then go to… constructs), just like a table of contents in a paper document does
not make purpose statements or preview paragraphs superfluous.

Continue there links help visitors explore a site or pursue a train of thoughts. Effective continue there links
clarify their destination by typically referring to pages or parts of pages identified as such in the table of
contents (and thus reachable by other routes, too), much like cross-references in paper documents would.
Moreover, they typically appear in expendable parts of the text (as in parentheses), or outside of it, possibly
grouped after a paragraph.

Go there and back links help visitors understand contents better by providing side information, such as
definitions or explanations, not unlike footnotes or bibliographical references in paper documents. To be
effective, however, such links must let visitors know what kind of side information to expect. This is the
case for bibliographical references, but very seldom for footnotes: you never quite know what to expect.
Poor hyperlinks are much like footnotes. Instead of allowing informed decisions, they tell visitors, “hey,
you might be missing something here—but I am not telling you what.” Most frustrating!

An engineer and Ph.D. in applied physics, Jean-luc Doumont now teaches and provides advice on
professional speaking, writing, and graphing. He also trains trainers and facilitates any process that
requires structuring and effective communication. Over the last fifteen years, he has helped audiences of all
ages, backgrounds, and nationalities structure their thoughts and construct their communication. You can
reach him at JL@JLConsulting.be and find out more about his activities at http://www.jlconsulting.be/.

Web Site Redesign: Improving Processes
By Michael Hendry, Webmaster, Philadelphia Metro Chapter

Editor’s note: This article was reprinted from September 2001 issue of Tieline, The Society Leaders'
Newsletter.  A slightly different version of this article also ran in the May 2001 issue of News & Views, the
newsletter of the Philadelphia Metro chapter.
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 The Web site of the Philadelphia Metro chapter (PMC) underwent a significant redesign last year. Our
efforts focused on improving the processes for disseminating information to, and receiving information
from, the chapter membership, while applying the latest ideas of accessibility and design.

In the five years since its debut, the chapter’s Web site had grown to accommodate new information and
new technologies, and had become unwieldy and difficult for our one or two volunteers to maintain. We
needed tools, we needed processes, we needed automation. And some sprucing up wouldn’t hurt (or so we
hoped). We were eager to test new theories of usability and accessibility in technical communication, and
as the Web’s power and range expands, it has become increasingly important to abide by standards that
ensure effective online communication. Meanwhile, the Society announced plans to merge the office Web
site with the (now defunct) regional and chapter Web site provided by EasyStreet, which had hosted
chapter Web sites for several years, so we had to find a new server. It was time for action.

The Preliminary Steps
I was happy when I found out that we would need to move our Web site. Because of the low cost, the
services provided by EasyStreet were minimal. STC volunteers, stretched to the limit like the rest of us,
shouldered the burden of technical support for EasyStreet. EasyStreet was a great, inexpensive way for
STC and many chapters to get started on the Internet, but you do get what you pay for. After some careful
shopping, I established a solid working relationship with a local Internet service provider (ISP) and began
the process of moving our Web site. For tips on shopping for ISPs, see "Choosing an ISP" at the end of this
article.

The philosophy of our current leadership in all aspects of volunteering is to split up the work, minimizing
the burden on each individual. I was fortunate to recruit a small, dedicated group for the initial effort. But
people need to get something out of the work they volunteer for. I believe that learning how to hand-code
HTML is no longer sufficient for technical communicators to be Internet savvy; you need to learn tools and
technology, but, more importantly, you need Web design and management skills. Therefore, to help
develop these skills, each volunteer would participate in the design and manage a section of the site. Once
the team was chosen and the site sections assigned, we were ready to tackle the design.

The Design
We designed the site following the World Wide Web Consortium’s (W3C) Web Content Accessibility
Guidelines, Version 1.0. We also followed guidelines of usability set forth by Jakob Neilsen and Jared
Spool. For more information about these guidelines, visit Neilsen’s Web site, useit.com, and Spool’s site,
User Interface Engineering. Our redesigned site has attained the W3C’s Conformance Level Double-A,
which means that it satisfies the first- and second-level priorities of Web site accessibility, as defined by the
guidelines.

Accessibility
First and foremost, the PMC Web site is not a corporate site. In other words, we don’t violate every
usability and accessibility rule to make our site flashy. This site is designed to disseminate information
from an organization of information dissemination professionals. It must be accessible to all and must put
into practice the usability principles we tout.

Here are some, but not all, of the important accessibility issues we’ve addressed:

We’ve provided alternative text links for all image links. The HTML text links below each icon don’t look
as sophisticated as a fancy graphical navigation bar, but they are much more accessible. And we use
optimization software to keep the graphics files as small as possible. (Our choice is Spinwave’s
GIFCruncher, but there are others. See Spinwave’s Web site for more information about this software.)

We don’t use tables for layout. Text readers cannot interpret tables used for layout, and confusion ensues.

We used style sheets for layout and formatting instead of HTML tags.
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We’ve ensured that pages are usable when scripts, applets, or other programmatic objects are turned off or
not supported. If this is not possible for your situation, you should provide equivalent information on an
alternative accessible page. The PMC Web site allows access to a text-only page for visitors using browsers
that can’t handle the scripts on the main homepage.

We’ve used W3C technologies (such as HTML without any proprietary extensions, EMCAScript, and
XML) according to specification. Other formats, such as PDF and Flash, need plug-ins that aren’t available
to all users. It would be much easier for us to publish the newsletter online in PDF format, but doing so
would decrease accessibility and make the newsletter practically unavailable to search engines. These days,
some search engines can index PDF files, but I don’t trust them to access a PDF file as specifically and
reliably as an HTML page or to be able to point right to the page the information is on. Also, the user might
not have the PDF plug-in.

Graphic Design
The colonial history of the Philadelphia area was a natural inspiration for the site’s theme, and I was
fortunate that the dedicated technical illustrator who works with me volunteered to help with the site.
I am wary of clip art. It tends to be overused and easily recognizable, and the relationship between the
nearest piece of clip art and the topic it purports to represent can be a stretch. So we pored over old
woodcuts, created our own when we couldn’t find any (there were remarkably few pictures of computers in
the eighteenth century), and cautiously made use of clip art when appropriate.

Behind the Scenes
We needed formal processes for generating and disseminating information, and we needed to automate
them as much as possible. Automated processes would ensure that the information on the site was up-to-
date and would eliminate the lag time between generating information and disseminating it. Users could be
more confident that the information they were accessing was current.

Because of the browser wars, client-side scripting (JavaScript) would have entailed writing multiple scripts
for everything we did to ensure that all browsers functioned equally well. I’m the last person to tout a
Microsoft technology, but Microsoft had the right idea when it came up with Active Server Pages (ASP):
Let the processing be done on the server, where we have control over the conditions. And ASP is one of the
few server-side technologies that come free with most ISPs. The following are some other technologies
we’ve taken advantage of:

Server-Side Includes, or SSI. These text files allow the server to write directly into the original page
before sending it to a user’s browser. Changes appear only on the output side; the user can’t tell that the
text wasn’t originally in the file, and the master file remains intact. With these files, we can keep most
dynamic information in centrally located text files, where they can be reused and updated more easily
(without risking the HTML files, which can be fragile). We use SSI for text that changes often, such as our
“What’s New” section.

Dynamic Web pages using databases. Our online reservation form, which uses a database to store
meeting and dinner reservations, was a smash. We will be incorporating more databases into the Web site.
Word scripts. We use several Microsoft Word scripts to process information, coding the HTML based on
styles in the document.

The Launch
Our team first met in February 2000 and began work in late spring, aiming for an August 15, 2000, launch.
We made the deadline by the skin of our teeth. The most significant problems we encountered were the
result of the browser wars. Since an analysis of our traffic showed that a large majority of our visitors use
Internet Explorer, we cater to that browser. We make sure Netscape Navigator doesn’t fail catastrophically,
but not all features work on it.

The Future
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We’re just about to embark on the second phase of the Web site redesign. This entails bug fixes, changes
based on feedback, and more process improvements. Based on the feedback we’ve received, some of the
changes we will be incorporating include the following:

•  Build the page based on a user’s window size by using Javascript to test the user’s resolution and
choose which Cascading Style Sheet to link to. Some people don’t maximize their browser windows,
and our current pages are constructed on the assumption that they do, which cuts off the right-side
navigation.

•  Create a printer-friendly option.
•  Incorporate a search engine (although the experts question their usefulness).
•  Create a membership section.
•  Add various other navigation aids.

We’re still flying by the seat of our pants on many processes, and this year of changes has pointed out
weaknesses. We will be formalizing processes both for posting to the Web site and working behind the
scenes.

The STC-PMC leadership, newsletter staff, and Web site staff are planning to work together to consolidate
and focus the chapter’s information stream. I see the Web site playing a central role in collecting and
storing information to be disseminated throughout the chapter. This will result in an easier and more
consistent process for those providing information to be posted on the site, and a more consistent and
reliable information stream for all of us.

Michael Hendry is director of publication services at TxR Global Technology Services. He is the
webmaster for the Philadelphia Metro chapter and technology reviews editor for its newsletter, News &
Views.

Choosing an ISP
Even if your chapter is not actively looking for a new ISP, you should be continually evaluating your
current provider. Following are some tips on shopping for ISPs:

•  Determine what technologies and services you want.
•  Research locally available ISPs on the Internet (www.findanisp.com and other sites rate ISPs).
•  Solicit word-of-mouth recommendations, if possible.
•  Compare the hosting packages of each candidate. The basic package should probably have all the

features you need.
•  Make sure your preferred ISP has a track record. A lot of ISP start-ups offer low prices and mega-

bandwidths, but they usually aren’t such good deals once you get past the hype.
•  Don’t forget to tell the ISP that you represent a nonprofit organization. Our ISP waived the setup fee

and doubled the amount of storage space usually allotted to the basic package.
•  In addition, certain ISPs offer deals to nonprofits, and some community sites offer low-cost or free

Web space to local organizations. If your budget is tight, and you can forgo some levels of service and
features, this option may be for you. For the Philadelphia Metro chapter, I determined that service and
support were the most important considerations, and went with an ISP with a proven track record.

Blue Pencil Editorial Calendar 2001/2002
The following calendar is subject to change, and contributions for each issue are not limited to these topics.
Topics on any subject are welcome at any time, regardless of the theme planned for that month.

September:
"Welcome Back"
Deadline: 8/10/01

October:
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Online Help and Web Development
Deadline: 9/10/01

November:
Employment Issues -- Flexible Work Arrangements
Deadline: 10/10/01

December:
Looking Back on Forty-Five Years of Blue Pencil
Deadline: 11/10/01

January:
Visual/Verbal Integration: Using Graphics and Illustrations Effectively in Technical Writing
Deadline: 12/10/01

February:
Embedded Help and GUI Design
Deadline: 1/10/02

March:
Documenting Something Besides Software
Deadline: 2/10/02

April:
Single-Sourcing
Deadline: 3/10/02

May:
Writing with Localization in Mind
Deadline: 4/10/02

June/Summer:
API Documentation
Conference and Year-End Wrap-Up
Deadline: 5/10/02

Advertisements:
STC Pittsburgh members may place a free business card-sized (2 1/4 inch x 3 1/2 inch) ad for their
products or services in each issue; non-member cost is $25 per ad, per issue. For larger ads, please contact
the editor. Ads received by the deadline will be included in the next month’s issue.

Guidelines:
Send your submissions to:

Chris Downs, Blue Pencil Managing Editor
600 Latrobe-Derry Road, Apt. B
Loyalhanna, PA 15661
Email: stcdowns@aol.com

Electronic submissions (email or diskette) are preferred. We can accept most word processing and graphics
file formats and can scan hard copy artwork. Contact us if you have any special requirements.

October STC Meeting
Third Annual STC Employment Networking
Night

WHEN:Thursday, October 18 2001, 6:00-6:30pm
dinner; 6:30pm - 8:30pm program.
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One of our most popular meetings - back by
demand and necessity.

Employment networking night features round-table
discussions with hiring managers, recruiters,
company owners, independent contractors, and
others with ties to the field of technical
communication.  Discussion topics will include the
job market in Pittsburgh, "do's and don'ts" of job
hunting, hot skills in our field, self-employment,
portfolios, and more.  We will even have a table
devoted to resume reviews and advice.  If you are
currently looking for work, or just want to prepare
yourself for an uncertain future, bring your resume
and attend this meeting!

Table speakers will lead participants through a topic
discussion.  If there is a specific issue you would
like to see addressed, please email your suggestion
to Noelle Conover, the meeting coordinator, at
nconover@sgi.net.  (And if you can't wait until the
meeting for help with a job search, please see the
employment page on our website, at
http://www.stcpgh.org/employ/index.htm.)

The meeting will be held on Thursday, October 18,
6:00-8:30pm, at Jameson's Restaurant in Oakland,
just off the technical row on Second Avenue, near
the Hot Metal Bridge.  (Between Second Ave and
Blvd. Of the Allies.)  Free parking is available in the
back.

The dinner will be a buffet. You may choose to
attend the meeting only at 7:00pm at no cost.

WHERE: Jameson's Restaurant, 45 Bates St, 412-
681-5210.

COST: Members $12; Non-members $13;
Students/unemployed $5.

RSVP: To Darlene Mullenix, Meeting Coordinator,
by Friday, October 12, 2001, at (412) 288-8676 or
dmullenix@federatedinv.com.

Pay at the door or mail to:

Darlene Mullenix, Meeting Coordinator
c/o STC Pittsburgh P.O. Box 133
Pittsburgh PA  15230
Make checks out to STC Pittsburgh.

There is no charge for attending only the program
portion of the meeting.

STC Pittsburgh 2001/2002 Meeting Dates
September 19:
Problem solving round table discussions.

October 18:
Employment meeting.

November 27:
Education opportunities.

December 8:
Holiday party.

January 16:
Presentation by Steve Bland from the Mayor's economic office regarding the City's hi-tech initiatives.

February 21:
TBD

March 19:
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Awards dinner. Tentative guest speaker is Matthew Ellison, director of the 2001 WinWriters Online Help
Conference.

April 17:
TBD

May 31:
TBD

STC Membership Statistics

New STC Member in August:
Lorrie L. Eury

Total Pittsburgh Chapter Members:
209

Total STC Members:
22,591

International Student Technical Communication Competition
The International Student Technical Communication Competition (ISTCC) is accepting entries for the
2001-2002 year. You can retrieve an updated copy of the Rules for the International Student Technical
Communication Competition (AD-57-2001) from the STC web site at www.stc.org, or you may contact the
STC office directly for a paper copy. Of special note is the addition of the category of student website
entries in this year’s competition.

If your chapter intends to sponsor a student writing competition this year, complete the survey form that
follows, and send it by October 5, 2001 to:

Society for Technical Communication
901 N. Stuart Street, Suite 904
Arlington, VA 22203-1854
Fax (703) 522-2075
Voice (703) 522-4114, Ext. 251
john@stc.org

Chapters that do not sponsor their own competitions can send entries to other sponsoring chapters. The
updated Rules for the International Student Technical Communication Competition provides details
concerning the entry requirements for the international competition, as well as guidance for use in
sponsoring a local chapter competition. It also includes an updated entry form. Please use this updated form
for your entries. Contact Karen L. Bachmann, ISTCC Manager, at 813-854-5971 or
karenlynn@mindspring.com if you need any additional information.

Here is the survey:

� My chapter is sponsoring a writing competition for high school students in the 2001-2002
school year.

We will submit the top � three entries � three percent of entries (please check one) to the
International Student Technical Communication Competition (ISTCC) by 1 February 2002.
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Name of Chapter: _________________________________________________________________________

Name of Chapter Competition Manager or Contact: ____________________________________________

Manager’s Address: _______________________________________________________________________

Manager’s Phone: _________________________________________________________________________

Manager’s E-mail Address: _________________________________________________________________

Please send me additional competition information about:________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

Please fax or mail this form by 5 October 2001 , to:

Society for Technical Communication

901 N. Stuart Street, Suite 904
Arlington, VA 22203-1854

Fax (703) 522-2075
Voice (703) 522-4114

john@stc.org

Thank you! We will publish your intent to hold a competition (and the contact information for the
competition manager) in upcoming issues of Intercom and Tieline.

New Canadian Issues SIG Signing Up New Members
Would you like to join a group of Canadians?  Now who wouldn’t want that opportunity?  The new
Canadian Issues SIG is now signing up new members, and you can be a part of this new group.  You’ll find
it’s a great way to network with other STC members in Canada and elsewhere, focusing on issues pertinent
to Canadians.  One of the good features now is that membership is free for the rest of the year!

In May 2001, STC formed a new SIG devoted to improving communication among its Canadian members.
I am Alexa Campbell, a long-time member of STC who is serving as SIG manager.  I’m inviting Canadian
STC members, and others who are interested in Canadian issues, to join this new group.

Right now, STC members can sign up for the Canadian Issues SIG for free until the end of the year.  SIG
membership dues will be billed in the 2002 STC dues notices scheduled to be sent out in November.  To
sign up for SIG membership, email your request to the STC membership department
(membership@stc.org).

Keys to the success of any organization are the enthusiasm and support of its members.  I hope many of
you will step forward to help make this one of the most effective SIGs in STC.  We can use volunteers to
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fill important positions of newsletter editor, webmaster, listserv coordinator, and membership coordinator.
The tasks are not hard nor take a lot of time; however, they will take your commitment.

We already have established a listserv that will be a good source for exchanging information and ideas.  To
subscribe to the list, go to http://lists.stc.org/cgi-bin/lyris.pl?enter=stc-ca-l, and click the "Join stc-ca-l"
button. Complete the information, and you’re there.  (Note that the "l" is a lower case "L".)
If you have any questions about the Canadian Issues SIG, please contact me, Alexa Campbell, at (204) 632-
2345 or acampbell@rrc.mb.ca.

Here is some information about the Canadian Issues SIG, its mission, its name, and its goals:

Mission statement
The Canadian Issues SIG fosters communication among Canadian members of STC to allow them to
exchange information and to discuss issues within STC that:

•  Are of a particular concern to Canadian members.
•  Arise by reason of political, socioeconomic, and geographical constraints because the members reside

in Canada.

Rationale for name
The name reflects the membership of the SIG and carries on the title of the Canadian Issues Committee,
which was formed in 1990. In the ten years of its operation, this committee helped identify and resolve
many issues of concern to Canadian members of STC. Membership in the SIG is not necessarily restricted
to Canadian members but is open to anyone with an interest in the special needs and concerns of Canadian
STC members.

Areas of interest
The Canadian Issues SIG explores the following areas of interest:

•  Increasing the technical communications profile and reputation across Canada.
•  Monitoring, helping shape, and publicizing technical communication education in Canada.
•  Helping evolve standards to encourage a consistency in the technical communications courses offered

across Canada.
•  Communicating the value of technical communication to business, industry, and academe.
•  Enabling educational institutions, industry, and practitioners to share ideas about technical

communication.
•  Promoting a professional development program for Canadian technical communicators by making it

easier to advertise such programs.

Goals
The following are the goals of the Canadian Issues SIG:

•  To link Canadian chapters, which are spread out geographically, and which lack a unified voice in STC
internationally.

•  To provide opportunities for Canadian members to communicate about needs, concerns, and issues that
are unique to Canada by virtue of geography, economics, or politics.

•  To provide a venue for promoting professional development activities for Canadian members.

Alexa Campbell, Canadian Issues SIG manager
Tel (204) 632-2345
Fax (204) 633-6075
email acampbell@rrc.mb.ca


